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Versies van Adlib Designer

o meegeleverd met uw Adlib-installatie
e updates gratis verkrijgbaar via MyAdlib, mits uw e-mailadres bekend is bij AIS
e keuze tussen Clickonce en stand-alone

Clickonce

Voordeel:
Automatisch altijd de nieuwste versie (mits internetverbinding)

Nadelen:
1. Automatisch altijd de nieuwste versie
e nieuwe releases zijn nooit volledig getest (dat is met de meeste software zo)
e Voorbeeld: Indexeerproblemen'
e Schadelijke bug?
o je kunt niet snel terug naar een oudere versie waar die bug nog niet inzat
= tenzij je nog ergens een stand-alone versie hebt
o je moet wachten tot AIS die bug oplost, of ermee leren leven
e Het Probleem van de Postbode
o als de postbode een paar keer gebeten is door de pitbull van Rozenstraat 15, dan
kan de postbode maatregelen nemen als hij daar moet zijn.
o als het gevaar telkens ergens anders loert, in telkens andere gedaante, wordt
het een stuk moeilijker.
2. Sommige IT-ers hebben er moeite mee en/of brengen er extra kosten voor in rekening.

Stand-alone

Voordelen:
1. Niet de nadelen van ClickOnce
2. Portable! Het kan evt op een memory stick (mits .NET 4 aanwezig is)
3. Je kunt meerdere versies naast elkaar hebben
e een oude vertrouwde versie blijft het doen terwijl je de nieuwe probeert

Nadeel:
Niet automatisch de laatste versie

! Discussie op LinkedIn. Problemen met zoeken blijken pas na veel onderzoek door de gebruiker (!) te zijn
veroorzaakt door problemen met Adlib Designer. http://goo.gl/IUcouF


http://goo.gl/lUcouF

Versies van Adlwin
Versie 7 en hoger:

e collection cloud;
e Look en Feel van Outlook 2007

Versie 6.6 en lager:

e geen collection cloud
e Qude vertrouwde look en feel
o denk aan uw vrijwilligers

Zie verder de release notes op www.adlibsoft.com.

DO: Van plan om een upgrade te doen? Lees eerst de release notes van de nieuwe versie.

DON'T: Versieverschillen bijhouden is net zoiets als een uitdijend heelal in kaart brengen.

Mappen

DO: Maak altijd eerst (maar niet telkens) een test-omgeving, en doe daarin je
wijzigingen

"test-omgeving" is een andere term voor "kopie waar je in mag knoeien "

& Tip! Tevreden met het resultaat? Maak een nieuwe kopie en knoei daarin verder

Wat zit waar?
zie Excelsheet Do's en Don'ts met Adlib Designher.xlsx

Gereedschap naast Adlib Designer

Adlib Designer Help
DO: Lees de foutmeldingen van Adlwin en zoek ze op in Designer.

Open Designer Help (¥ Tip! maak een apart icoontje op de desktop!)
—>helemaal onderaan General topics = plusje

- helemaal onderaan Error codes > klik

- klik in rechterpaneel - Ctrl-f = geef foutnummer, enter: voila!

DON'T: De foutmeldingen van Adlib Designer zijn niet gedocumenteerd.

Designer is geen file manager, geen windows verkenner
.. maar die heb je wel nodig!

DO: in Windows Verkenner, gebruik Detail View en hou zicht op de kolommen voor naam, gewijzigd
op en type. Zo kun je gemakkelijk vinden wat je zoekt:


http://www.adlibsoft.com/
Do's%20en%20Don'ts%20met%20Adlib%20Designer.xlsx

Zoeken in da

@'&L"' | » Computer » TBOST6100A (C) » AdIiibUG » Adiib Applications » data » -T4]

Organiseren In bibliotheek opnemen « Delen met « Branden Nieuwe map
» S Favorieten i Naam Gewijzigd op Type : Grootte
4 | BORROWERINF 21-1-2010 16:33 Setup-gegevens 33 kB
4| Bibliotheken 4 | BUDGET.INF 21-1-2010 16:33 Setup-gegevens 8 kB
[ Afbeeldingen 4 | CIRCUITINF 21-1-2010 16:33 Setup-gegevens 8 kB
> 3 Documenten 4% | COLLECT.inf 12-2-201417:19 Setup-gegevens 237 kB
. J“. Muziek 4 | collname.inf 21-1-2010 16:33 Setup-gegevens 7 kB
> [5)] vanToshll 4 | COMSERVA.INF 9-4-201019:37 Setup-gegevens 16 kB
> E Video's 4 | COPIES.INF 26-3-201012:46 Setup-gegevens 40 kB
4| costs.inf 21-1-201016:33 Setup-gegevens 4 kB
> %@ Thuisgroep 4% | CURRENCY.INF 26-3-2010 12:46 Setup-gegevens 6 kB
4 | document.inf 9-4-201019:37 Setup-gegevens 103 kB

DO: Maak in Windows Verkenner reservekopieén van alles wat je wijzigt, voordat je het wijzigt.

DO: Geef je reservekopie een andere extensie dan het origineel.
En wel om deze reden:
Adlib Designer leest automatisch alle definitiebestanden die hij kent.

* INF - database definities etc;

* PBK - applicaties

* FMT - schermdefinities, ook wel tabbladen.
* IMP - importjobs

* EXP - exportjobs

Als je de extensie niet wijzigt, zie je in de Application Browser niet makkelijk wat je reservekopie is en
wat je werkbestand is.

Ga als volgt te werk:

1. klik het te wijzigen bestand aan, geef CTRL-C, CTRL-V
2. Van de kopie, verwijder 'kopie van' en geef het een extra extensie '.bak'

In dit voorbeeld is hebben we twee reservekopieén, eentje met extra extensie, eentje zonder.

In Windows Verkenner In Designer, App Browser
[ ] collect.098 19-2-2014 11:10 098-bestand i [H-T cincuit
4% | COLLECT - kapie.inf 12-2-2014 17:19 Setup-gegevens B collect
4 | COLLECT.inf 12-2-2014 17:19 Setup-gegevens B collect
_ COLLECT.inf.bak 12-2-2014 17:19 BAK-bestand B collname
|| collect.096 5-2-2014 11:39 096-bestand 1 conserva

Collect.inf.bak zie je rechts niet. Dat is ook goed, want dat is je reservekopie, en daar wil je
voorlopig afblijven.

Collect - kopie.inf en Collect.inf zie je allebei wel in Designer, maar je ziet geen verschil. Dat is een
recept voor problemen.

Profs werken met DOS-prompts
Als je Adlwin opstart, leest-ie altijd de HELE mappenstructuur en zet die in het geheugen. Dus als je
iets wijzigt in Designer, en dat opslaat, dan zie je die wijziging niet, totdat je Adlib afsluit en opnieuw



opstart. Meestal zijn wijzigingen niet in één keer goed, dus je moet voortdurend afsluiten en weer
opstarten. Profs werken met DOS-prompts.

& Tip! In Windows verkenner, houdt control en shift ingedrukt, geef rechtermuisklik op de

applicatie-map (hier library+museum) en kies 'Opdrachtvenster hier openen’.

o g o
i | | Readme.td
J library+museurn _
i Utvouwen

| museum basis

/ MUSeUm opac In nieuw proces openen

| SCreens In nieuw venster openen

| texts VLC media player - Aan afspeellijst toevoegen
> 1 Werddoc Opdrachtvenster hier openen
ki ‘; lanrnreer Tin LT " [ B I

Dan krijg je een DOS-box in die map, geef ..\executables\adlwin.exe (of ..\bin\adlwin.exe) en Enter.

Dan start Adlib. Ben je eruit, alttab naar die dos-box, pijltje omhoog, enter. Is minder werk dan
muizen.

BN Administrator: C:\windows\system32\cmd.exe

C:\AdlibUG\Adlib Applications\library+museum>..\executables\adlwin.exe

Zo ook: import jobs testen, adapls compileren, en zo voort.

Andere mogelijkheid, als je steeds met dezelfde applicatie werkt: een sneltoets!
Rechtermuisklik op het Adlib-icoontje, En dan sneltoets invullen, bijvoorbeeld Ctrl - Alt - A.
CTRL-ALT is hetzelfde als de rechter-Alt-toets

Beveiliging Details Vorige versies
Algemesn Snelkoppeling Compatibiliteit
B
Doeltype: Toepassing
Doelmap: executables
Doel: ibUG"\Adlib Applications"executables\adiwin exe"

Beginnen in: "C:AAdib UG \Adlib Applications“library+museum”

Sneftosts: Cird + Alt = A
Uitvoeren: | Normaal venster - ]
Cpmerking:

Bestandslocatie openen] ’ﬂnder pictogram... ] ’ Geavanceerd. .. ]

QK ] [ Annuleren ] [ Toepassen




Een goede editor
Windows kladblok (a.k.a. Notepad) is er altijd.

Notepad++ vind ik een goede, open source, gratis, er wordt nog steeds aan ontwikkeld, support is
goed (StackOverflow).

Werken in Adlib Designer

cenneegrote DO 7 zet altijd je werkmappen goed!

Vrijwel alle verschillende gereedschappen in Adlib Designer hebben hun eigen werkmap-instelling.
Dat moet ook, want met het ene gereedschap wil je ergens anders werken dan met het andere

2

1. kijk in de statusbalk onderin of het goed staat

gereedschap, maar wel tegelijkertijd.

d Vuistregel: in elke tool waar je dit ziet

2. zoniet, stel in op de map die je nodig hebt.

De laatst gekozen map voor elk afzonderlijk gereedschap wordt apart onthouden. De volgende keer
dat je Designer opstart, krijg je de laatst gekozen instelling. (Tenzij je net een update van Designer
hebt gehad.)

Adlib Designer zelf: op de hoofdmap. Dat is dan meteen ook de map voor de Application Browser,
maar die kan onafhankelijk worden ingesteld!

'ADLIB Designer [7.00.14]

dit View Tools Appllcatlonlanguage Optlons Help

[ ChadlibUavAdlib Applications ]

De record lock manager: op de data-map.

B ADLIB Designer [7.00.12]

Q] O BB wweﬁaﬂw@ Q.




[T B

= Edit Help

] <XEE R

Database Record number User Process Id Date and time

Locks: 0 10-5-2014 15:41:41 CrtdibUGNAdiib Applications data

FAQ: Ik krijg foutmeldingen 'Record lock', maar ik zie helemaal geen record locks, hoe kan dat nou?
Antwoord: data-map!

Databases, datasets en datasources

Databases
* INF - hierin definieer je datasets, velden, indexen, hun onderlinge relaties en de relaties met velden
in andere databases.

Elke database kan 23" = 2.147.483.648 records bevatten. Dat bereik aan records kun je onderverdelen
in datasets.

1+ 5y DOToWer
G- [ budget MName Lower limit Upper limit
[ circut i archive 100000001 130000000
= collect i8 archiveaccession 100000001 110000000
. - Datasets (B) id archivecatalogue 110000001 130000000

gl Indexes (124) pllk e [io000001 [20000000
- Fields (565) =|| | Fintem 1 10000000
-l Intemal links (2) i museum 1 20000000

- Feedback databases (2)

Zowel databases als datasets zijn datasources. Alleen in datasources kun je zoeken. Op die manier
kun je deelcollecties inrichten.

DO: Vraag je altijd af:

e hoe zinvol is een onderverdeling?
e Watis het voordeel voor wie?
e Welke last ondervindt wie van die onderverdeling?

DO: Houdt altijd de mogelijkheid om te zoeken in de volledige range.
Zou het niet handiger zijn als je kon muteren in de volledige catalogus?
Topstukken in een aparte dataset? Liever een vinkvakje

Hoe registreer je boeken die in de vitrine liggen (museaal) maar die ook door individuele bezoekers
ingezien kunnen worden (uitlenen)



Datasources bepaal je in de applicatie.

Applicat\on browser
File Edit  View Application language  Help

= =<1 EE ﬂaa Q-

=[] C\AdibUG\Adib Applications

(] Awvast aniti vius license
-] Copy of adapl sources

- fli Adib Bibliotheek+Museum 4.2

Data source properties | Access rights |

1]

Path to the database

1) data folderlabel ./data
) damp Database COLLECT E]
-] executables
(7] images Data set v]
£+ ] library opac
¢ F-f Adib Biblicthesk Publiskscatalogus 4.2 commandGraupBox
&[] librarysmuseum Command

-] adapl sources |l Type g
: E a:ap:bln Data source type [Nnrmal database v] B
adapls

[E] £ Command arguments
@ Objecten in eigen beheer
--[@ Objecten in beheer van derden dataSourceAdaplGroupBox
--@ Archieven finschrijvingen) Adapl procedure ad
g g;’w";;:;‘kf:;f:::’ adaplArgumentslabel |
(3 Boeken 3
3 Audiovisuele malerislen Menu texts
- @ Atikelen Text
- @ Tidschriten
@ Losbladigen Language Text
(@ Digitale bronnen » Objects
Desiderata 8
g Boclddocumeriatic _ Dutch Objecten
--@ Personen eninstelingsn French Objets
g THTI\ZEHLJJSM . German Objekte
- woorden
(@ Binnenkomst Arabic
@ Verzending Ttalian
@ Binnenkomends bruiklenen Greek J—
--@ Uitgaande bruiklenen
--[@ Conserveringsbehandelingen Hel
@ Tentoonstelingzn P
(@ Onderzoek ‘gebruik Help key DS_INTEGRATEDCOLLECTION o
.. @ Vemsllinnan A4

ChadlibUG\AdIib Applications\library=museum\Adlib Bibliotheek+Museum 4.2\Objecten

Applicaties zitten in aparte mappen.
In de map library opac zit de applicatie Adlib Bibliotheek Publiekscatalogus 4.2 en die heet adlib.pbk

In de map library+museum zit de applicatie Adlib Bibliotheek+Museum 4.2 en die heet OOK adlib.pbk
PBK is van Parameter BlocK en niet van Windows PhoneBooK.

Elke applicatie bevat verscheidene datasources.



tags en velden

Een tag moet:
1. bestaan uit 2 karakters.
Toegestaan:
a-z,A-Z,0-9,%en _ maar %0 is gereserveerd voor recordnummer
dus 26 + 26 + 10 + 2 = 64, 64 - 1 = 4095 mogelijkheden
2. uniek zijn binnen een database

DO: Nieuwe tag nodig? Gebruik de object searcher in Designers openings-scherm.

¢ ADLIB Designer [7.1.0.27]

2 b C AS33P 9[Rlas ¢ 3

Run search tool

DON'T: Het verrekijkertje in de Application Browser is daarvoor minder geschikt.

XX

aApplication browser
File Edit View Application language Help

== 1x)

-] ChAdibUG\Adib Applications o | lndex ties | ad
(] adapl sources [ Find tact in the object tree ]_
i adaplbin H |

Y ADLIE Designer [7.10.27]
File Edit View Tools Application language  Options Help

AV 2N B33P 5 ARG

05,/12/2014 11:24:47 Search for Tag with text 4" in folder 'C:\Adlib UG \Adlib Applicationsdata’ started.
05/12/2014 11:24:45 Search completed. files searched = 43, objects found = 0

e R

Search
Cbject category Search for

Tag | X

Ciptions File specification

lgnore Case [¥] Applications (adiib pbi)
Search substrings Screens (™ fmt)

Include subfolders Databases (*inf)

Clear previous resufts Adapl programe (*.bin)

Progress
Files

[ Foder |[ stan || Hep |

CAAdibUGhAdiib Applications'data




Velddefinities
DO: documenteer per project in een tekstbestand wat je aanpast en waarom, zodat je later nog weet
wat je gedaan hebt. Hou het beknopt en overzichtelijk.

Waarom: wil men ooit een applicatie-upgrade, dan weet je (of je opvolger) welke maatwerk je na de
upgrade opnieuw zult moeten doen.

DO: maak altijd een veld-definitie voor velden die voor de gebruiker zichtbaar zijn.

Toelichting: je kunt in een willekeurig tabblad een veld maken met een tag dat je verder nergens
nader definieert. Dat werkt, je kunt er zelfs op zoeken, maar het is bad practice.

DO: maak ook altijd een veld-definitie voor link-referentievelden.

Toelichting: Veel overzichtelijker! Tot en met applicatie-versie 2 werd dit vaak niet gedaan. Wil je
over naar MS-SQL, dan moet je wel. AlS heeft er tools voor, vraag de helpdesk.

Naamgeving van velden
DON'T: spaties in data-dictionary namen.

DO: gebruik _ (underscore) voor spaties en rubriceer met . (punt).

L' - ' -]
huidige_standplaats (24)
huidige_standplaats Iref (2a)
huidige_standplaats soort (2B)
huidige_standplaats datum (2C)

huidige _standplaats bijzonderheden {2D)
huidige_standplaats geschiktheid (2E)
huidige_standplaats autorsator (2F)
cument_location.authoniser Inef (2f)
huidige_standplaats tijd {2G)
volgende_transport methode (2H)
volgende_transport methode Iref (2h)
volgende_transport geplande_datum (mP)
volgende_transport tijd (2F)
volgende_transport referentie (21)
volgende_transport contactpersoon (2J)
volgende_transport contactpersoon Iref ()
volgende_transport bijzonderheiden {2K)
volgende_transport locatie (2L)
volgende_transport locatie Iref (21)
volgende_transport locatie soort (2M)

Zoeken naar opgehaalde velden en linked field mappings
Welke velden worden opgehaald uit een andere database, en hoe?

& Tip! Gebruik de kolom Linked Database in het fields-overzicht

1. Sorteer op Linked Database, dubbelklik op het veld.
2. Voaila, linked field mappings



a}\p plication browser

Edit  View

Application language

Help

CoY Y=

Q.

o || Fediat |
Name Tag Linked database Domain Group Type
® associatie.onderwerp tax Nj Associated_subject Text
=™ inhoud.onderwerp.tax Ng taxonom Content_subject Text
™ taxonomie.wetensch_naam 15} taxonom Taxonamy Text
™ onderzoek.referentienummer N research Research Text
! ] eproductie referentie lEn_lphoto | |Reproduction
5!;?“"""": “‘N] = yervaardiger vV people MAKER Production Text
‘nsta”!"g C‘n; ((ZE’L) ™ associatie.persoon ki people Associated_person Text
:hm;?;_zu;mer @ : mhu.m::persuun.‘rj\.aam 117 pmp:e e ICunter;t_permn Ie:tt
attematief_nummer soort {14) = inscriptie.vervaardiger people nscription E
ahematief_nummer datum (15) huidige_eigenaar HE people Text
attematief_nummer insteling (16) ® stanplaats.autorisator SP people CURATOR Location Text
afdeling (AG) = yerwerving.bron VN people ACQUISITIONS...  Acquisition_source Text
anpplicat\onbrowser - =
File  Edit View  Applicationlanguage  Help
== OO0 RAB @
- ®_documentatie signatuur (si) » || Field | Linked field Image Relation fields | Link screensl Linked field mapping] | Defaul values | Muti language fields | Useri
= I8 vje_t Copy fields from linked record
- @ reproductie referentie (FN)
- m reproductie referentie Jref fn Source field in Destination -
rep {n} e Fields in COLLECT Textindex CharacterSet Encading =
- & reproduciie foma.
- m deel_van referentie (bt} » reproductie.formaat |1 utfa System.Text,UTF... =
y ete
- @ deel_van_referentie.lref (1)) referentia_nummer reproductie.referen... |1 utfs System.Text.UTF...
- @ deel_van beschrivingsniveau (ba) " ;
. m deel_van fitel (OH) vervaardigingsdatum | .. ||.. | reproductie. datum 1 Utfa System.Text.UTF... Delete 2l
- @ deel_van bizonderheden (B5) reproductie_soort reproductie.soort 1 uta System.Text.UTF... J
= delen referertic (nt) vervaardiger reproductie vervaar... |1 utfa System.Text.UTF...
- delen referentie Iref (1L) 2
= delen beschrijvingsniveau (ng) )
o Aslar el 01V Co




Copy, Paste en Delete in Adlib Designer
Do: Kopieer liever hele INF's, PBK's etc van je test-omgeving naar je productie-omgeving.

¢ Voorzichtig! Met twee Designers open, de ene op test en de ander op live, kun je
complete veld-definities van de ene naar de andere omgeving kopiéren.

Weet wat je doet, want een complexe definitie (met veel toeters en bellen), mag in de doel-
applicatie geen conflicten geven.

Wees voorzichtig met de DELETE-toets en -knop!
In de Application Browser krijg je tenminste nog een waarschuwing

i~ @ volgende_transport locatie
----- ® volgende_transport locatie
..... ® volgende_transport locatie Enalish Caurier

fo » Dutch Koedier [¥i)

D Intemal links (2)

Language Text

G- Feedback databases (2) French
F rrllnamea German
volgende_transpart hijzone Text
volgends_transport locatis .
volgende:tmnzort.locatie Language Text 3 pamng
volgende_transport locatie English Courier
¢ tem Koedier (4) (4) » Dutch e
D Intemal lirks (2) | & Ok to delete field 'Koedier (Xi)' ? |
-1 Feedback databases (2) French ==
-5 collname German
I conserva Arabic
][ copies - l Ja ; l Nee l
1@ costs Italian
1-[i@ cumency Greek

.. maar in de Import Job editor, mappings ben je meteen de hele regel kwijt.

File  Run Help

HGGE2O

| General | Mapping | Options | Advanced | Run |

Source field Eeelstination Comments Language g;?:tne
- - = Overarte
1 %0 : recordnummer COvenwrite
X2 ti [ ] el Ovenwrte
r[x3 ¥ ) Ko=d Dumnat
% :] + mapping ContextMenuAddMenultem

£3  mappingContextMenuDeleteMenultem eh

Ermai

DO: gebruik Context-menu's! Rechtermuisklik, en dan verder.



Screen-editor
What You See IS NOT What You Get.

Zoals het in andere software werkt, werkt het hier NIET.
DO: zo min mogelijk muizen!

DO: zoveel mogelijk met de pijltjes-toetsen!

DO: houdt dit schermpje bij de hand als je aan de slag gaat

Designer Help = Screen Design Managing = Screen Objects = het tabelletje met de keyboard
shortcuts

[— = = i

-
% Adlib Designer Help

| e &
Werbergen Vorige  Afdrukken  Opties

|

-
|| mhoudsopgave | Zoeken There are some keyboard shortcuts available for navigating and moving

screen elements:
= Qzl Adlib Designer Help
@ Introduction

- 0 BEE)

& () Soreen design [Key or shortcut  |[Function
[7) screens |@‘, Shift+Tab |Selects the object to the left, or above.

Condttional screens and fields , -

= E Interface functionality for screen design |G' Tab |SE|ECtS the Ub]ECt to the nght’ or below.
Accessing screens Home Selects the first object, in the left upper
Managing screens corner, of the screen (not a box).
Managing screen objects - . -
Edting screen object properties ‘End Selects the last object, in the right lower
Saving modifications corner, of the screen (not a box).

@ Froperties of screen objects shift+ i, ® = @ Changes the size of the currently selected

@ Adib screens, tags and parameters

object(s) in the direction of the arrow, if
@ Application setup

the object allows it (see the next
@ Da.tabase setup paragraph).
@ Using ADAPL
@ Wanaging translations ctr1+ @, ¥, ® @ Moves the selected object(s) in the
@ Import and export direction of the arrow, but won't move
@ General topics other objects accordingly, so overlapping
may take place.

Shift+Insert Inserts an empty line above a selected
object, and moves all objects below it one
line down.

Shift+Delete Deletes the line that holds the currently
selected screen object, and moves all
objects below it one line up.

m

..en verder veel plezier bij de workshop van Jeroen ©



Over Indexeren en data-corruptie

d Vuistregel: if it works, don't fix it.
¢ Vuistregel: kijk eerst wat het probleem is en kies dan de oplossing

d Vuistregel: Bij twijfel: bel of mail de helpdesk

Een hele database re-indexeren is zelden een goed idee

In SQL kun je in detail kijken wat er mis is met je indexen

Een SQL conversie is een prima manier om data-corruptie boven water te krijgen.
Data-corruptie oplossen? Zoek de foutmeldingen op in Designer Help en bel of mail de helpdesk.
Voor gevorderden: import.exe met de -fix optie

http://www.adlibsoft.com/support/manuals/maintenance-guides/small-tools



http://www.adlibsoft.com/support/manuals/maintenance-guides/small-tools

Import en export
Export in Designer? Misschien voor reparatie-werk.

De export in Adlwin is bijna altijd voldoende

Import: zeer krachtig, mede dankzij adapl

Rollen en Rechten
Hou het simpel! Meer dan drie rollen heb je zelden nodig: Beheerder, Registrator, Bezoeker

Voor tijdelijke projecten: denk aan een aparte applicatie

Voorbeeld: de tentoonstellingsteksten moesten in Adlib worden gemaakt door bureau X.

twee velden bijgemaakt voor de teksten (En en NL)

schrijfrechten op die velden voor bureau X
een aparte applicatie gemaakt met 2 tabbladen, allebei helemaal read-only op die
tekstvelden na.
bureau X heeft via Remote Desktop alleen toegang tot die velden.

Nieuwe tools

translations manager

P Translations manager -
File Edit Columns Tools Help
1 GH FEDes B O
No.  Englsh Duich French Gemnan Custom 1 Custom 2 Custom 3 Type Teg  Path

fhmmm and subject terms | Samenvatting, classficatie, t... | Résumé et termes sujets Abstract und Schlagwérter Aprprpévor ko . | Sereen file abstract frnt
2 Materizl type Materiaalsoort Type de documert Medientyp Tinog uhton Screenfield label | ms abstract frnt
3 Bl fom Bibiear. vom Fome bibliographiaue Bl Fom BBl uopei Screenfisldlabel | BV abstractfmt
4 Language Taal Langue Sprache Niaoa Screenfisldlabel | TA abstractfnt
5 Level Niveau Niveau Niveau Eninsse Screenfisldlabel v | sbatractfmt
6 Notes Opmerkingsn Notes Bamerkungen Moporpriosi | Scresnfiskdlabsl |op | abstractfmt
7 Clsss mumbsr typs: s e " T Sorsen fisld bl | ct abstract ft
8 Class number Open Tt olde il Kias Apude déong | Soreen field label | o abstract ft
3 Subject temn type Text types Schiagworttyp Tinog Bepamiko.. | Screen field label o abstract frnt
10 Subject temn ] fadli pbk) Schiagwort Bepomwdc dpog | Screenfield label abstract frnt
& Proper name 7] Databases Cinf) Name Kopto dvous Soreen field abel |1 absiract ft
12| Person keyword type Sereers (i) Persanerschizgn. Typ Tinos ME -k mp...| Sereenfiekd label i abstrmct ft
2| Name [l et s o) Name Ovops Scrsenfisldlabel | PT | sbstractfnt
4 |Rok Ralle Pélg Screenfisldlabel | P sbatractfmt
15 | Geographical keyword Falder Geogref Schiaguort Tewypog MéEn« | Sosenfeldlsbsl |GT | sbstctimt
6 | Peiod Zaitraum MepioBos Sorsenfisdlabsl | TP abstract frt

CAAIDUG\AdiD Applicatiors'sereens [ e | .

17 Start date Anfangsdatum Huvia évaplne | Screenfield label | BD abstract frnt
12 End date 7] Inchude subfolders Enddatum TehwirpAta  |Screenfieldlabel |ND | abstractfmt
19 Digital references Digitale Verneise Wnouaréc avag... | Label for group box abstract frnt
20 Description G S B Bescretuns ] e Sereenfieldlabel | AT  abstractfnt
21 Reference {Dig. Verneis Avagopd Sereen fiskd abel | et abstract ft
T Hostract . Meplinun Sersen fiskd bl |52 abstrac ft
23| Promy| Anslysis|Dig. rel. | Urgentee | Anslyse | Dig.ref. | Pronts | Analyse | Réf.rum Prontst | Ansiyss | Dig Verweiss Mporspobmrter || Screen tls acosssion_snaly
FrE . TR PR - . .




recovery jobs

% Adlib Designer Help o |E] = |
W e & B
Verbergen  “orge  Afdukken  Opties
houdsopgave | Zosken Adlib recovery (repair with Adlib’s proprietary logging file)
= [() Adib Designer Help ) ) ) ) i
@ Irtroduction with Adlib logging, you save changes in your Qata from t_he moment you set it.
@ Screen desian When a file has become corrupted, and you wish to repair your Adlib system,
@ Application setup first put back a functioning backup. You can restore the changes made after
@ Database setup the backup, by reading and executing the logging file through the Recovery
@ Using ADAPL tool in Adlib Designer.
@ Managing translations To start this tool, choose View > Recovery in the main Designer menu or click
% Import and export the button for it :
=] General topics p—
2] Adib file types and folders y
z Searching for Adlib objects
2] Backups. and logging and recovery 1. First make sure you have selected the right work folder (see the status bar
[2] User authertication and access rights of the tool window). This should be the folder in which you have just placed
[2] Status management of authority records a backup file to recover, to make it your new live Adlib application. If
[2] Record locks necessary, choose File > Working folder or click the button for it, to select
E Colour your Adlib application another folder.
E Windows Image Acquisition
2] Using a web browser control 2. On the General tab for the Recovery file option, you select the logging file
2] Using an HTML field you need to import. For Meta data tag you can provide a tag in your Adlib
[2] Showing the upwards hierarchy of a linke: system in which you want to import the metadata that is present in the
[?] Character set conversion of your data anc logging file (this is information about dates of modification, and so on). The
[2] Insetting special characters in text meta data tag is not mandatory.
E Working with non-standard dates ~

application tester

0 < &
Verbergen  Vorige Afdukken  Opties

Inhoudsopgave  Zoeken |

Testing your application for errors
Geef op welk trefwoord u wilt zoeken:

Adlib Designer has a special tool with which you can check your application for certain
Jrester common errors. Start this Application tool by choosing Tools > Application
or by clicking the button for it in the main Adlib Designer window:

Onderwerpen weergeven

Selecteer het weer te geven onderwerp:

General topics: testing your application for ... This was originally a tool used by the Adlib developers to test their own work on Adlib
What s Adib Designer Designer, by checking the files for compatibility and consistence. This was to make
sure that Designer can read files from all versions of Adlib properly, and save them to
disk (unmodified) the same way the old ADSETUP or DBSETUP tools would. These
specialized tests can be found on the Advanced* tab, and most users can disregard
them.

However, on the Options and file types tab you'll find settings to perform a
consistency test on your own application. This test checks the file types and work
folders that you select on this tab, for:

+ errors in path names (meaning references to Adlib objects, like screens and linked
files), that point to missing files or typing errors in the path names;

errors in link definitions (meaning the syntax of path names: if file separator
characters are being used properly, although in Designer you no longer see these
characters in object properties because paths to datasets are now split up in
different properties);

multiple (duplicate) use of tags and link reference tags in .inf files (because these
must be unique);

undefined tags which are being used in linked field definitions, like undefined link
reference tags. Every tag you use, should be defined in the data dictionary.

spaces in field names.

character set conversion tool
Voor intern gebruik?



1Q;J-'l'«r:u;:uliu:atiu:-n character set conversion - B X
Target character set
{®) Unicode (UTF8)
{1 AMSI ISO-Latin)
O DOS (Western Europe) E Include subfolders
Progress
Files Maodified
| characterSetConversionProgressBar |
| Start | | Cancel | Help Work Folder
ChAdlibUGNAdIb Applications or
application colours
‘ADLIB Designer [7.1.0.27] - B8 X
File Edit View Toals Application language  Options Help
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batch manager
Kan handig zijn!

@ BatchlobManager —_— TE B o " (=& = ]

File Job  Help

I TYYTRN:

/| Job (checked = dependent) Type Description Status Records Emors Speed Started Ended

e 0 . . e

R B
Werbergen Vorige  Afdrukken  Opties
Inhoud: | Zocken Interface functionality: using batch jobs M
] ) |
“ Gxcstiopiwelcheivmor mkienkes: The purpose of the Batch job manager is to be able to sequentially run several
| |tester import (or export) jobs (called a "batch") automatically. You only need to use
this functionality if you have one or more batches which you'll want to run more
o than once.
[ e ] To access the Batch job manager, click the Run batch manager button in the
Selecteer het weer te geven onderwem: main Adlib Designer window:
Ly’
General topics: testing your application for emors
What is Adlib Designer
" Creating a new batch job H
& - - -

Einde presentatie.




